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CHAPTER 1:  INTRODUCTION TO CALCS 
1.1 About Calcs 

The COMPASS Emission Calculation and Process History (“COMPASS-Calcs” or “Calcs”) 
module facilitates the collection, storage, and reporting of Air Emissions data, including 
emissions inventory and calculations, and Title V permitting. Other modules of PDC’s 
COMpliance ASsurance System (COMPASS) handle MSDS management, and other 
environmental, health, and safety compliance needs. 
 

Calcs incorporates data from such items as stream composition and process rate, and computes 
overall emission calculations needed for reporting purposes. Once the data is calculated, it can be 
automatically updated in the EI (Emission Inventory) section of COMPASS. 
 
1.2 Manual Procedures Affected by Calcs 

Maintaining Process Data from plant operations – manual procedures that have been used to 
record process data from plant operations that are pertinent to emission calculations, such as fuel 
usage, run times, and throughputs, would likely be discontinued in favor of using the Calcs 
module, for the following reasons: 

a. Although process data can be manually inputted into Calcs, many users find it more 
convenient to export spreadsheets containing the previous year’s process data for Sources 
of a particular type (e.g., Tanks), and then ask process engineers or supervisors to provide 
the current year’s data.  These updated spreadsheets can be imported into Calcs using 
standard program features. 

b. Process data that has been updated in Calcs can immediately be used to calculate and 
characterize air emissions, because the “set-up information” for each Source’s calculation 
regime, such as formulas, factors, and stream compositions, are usually defined in the 
system and require no updates. 

c. Calcs maintains process data in its database for every year that it was used, and enables 
users to retrieve the data and the emissions that were calculated based on the data with 
minimal effort.  In addition, users can re-calculate emissions for prior years by changing 
the process data for that year, applying, at their option, either currently assigned formulas 
and factors, or the ones assigned in the previous year (unless they were deleted or 
modified). 

 

Calculating Emissions – the manual procedure for calculating emissions in CPC facilities, as in 
most other plant where programs such as Calcs are not used, involves inputting process data into 
MS Excel workbooks where the formulas, factors, and streams have been provided to enable a 
calculation of air emissions.  These workbooks tend to be calendar year-specific, complex, and 
extremely large – factors that create special challenges for users in organizing, archiving, and 
using them.  They also present significant challenges to making alterations or updates because 
calculation methodologies are not explicitly defined but, rather, exist in hidden areas that would 
be familiar only to the workbook author, such as cell formulas, pivot tables, and macro code.  
Because Calcs contains explicit and readily observable methods for calculating emissions and 
speciating chemical-specific emissions from “Total VOC,” users generally find that calculating 
emissions in Calcs offers a superior work process than XLS-based approaches. 
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Responding to Emission Calculation Questions from the TCEQ - the manual procedure for 
responding to TCEQ questions about how emissions were calculated usually involves a “cut and 
paste” of data from one or more worksheets.  The process of extracting portions of the data 
contained in spreadsheets that contain macros and formulas can itself be very challenging, but 
the major drawback for manually preparing responses to TCEQ questions is the fact that the 
excerpted data rarely explains how calculations were done.  Thus, CPC staff must describe their 
calculation methods in e-mails or letters, which introduces the possibility of inadvertently 
making an incorrect statement in such documents.  Calcs provides a special “Emission 
Calculation Parameters” report that can be produced for any Source, or group of Sources, with 
little time or effort.  That report presents the values of relevant process information used in the 
calculation, the emission calculation results, and all aspects of the methodology, such as 
formulas, factors, and stream compositions.  In addition, this report always provides an accurate 
summary of the methods and data that were employed in the calculation of emissions for which 
questions have been raised, so there is no chance of erroneously explaining them to the TCEQ. 
 
1.3 System Requirements 

The following platform is strongly recommended to operate the Calcs application: 
  Pentium II PC running at 250 MHz. with 64 megabytes of RAM and 50 megabytes of free 
disk space. 

 

The following platform is the minimum required to operate the EI application: 
  Pentium I PC running at 90 MHz. with 25 megabytes of free disk space and 32 megabytes 
of RAM to obtain reasonable performance. 

 

The following operating systems are supported: 
  Microsoft Windows 95, Windows 98, Windows ME, Windows XP or Windows NT 
Operating Environment, (all Trademarks acknowledged). 

 

The following Database Management System (DBMS) software is supported for the 
Data Repository: 

  ORACLE 7.3 and higher, Sybase SQL Anywhere 5.5 and higher. 
 
1.4 Installation Instructions 

Directions for the installation are furnished in a separate document entitled “Installation 
Instructions,” which is provided with this operations manual. Calcs should always be loaded onto 
a local or network hard disk under the directory structure: <drive>:\... \PDC\ACM\CALCS. The 
installation program creates this structure below the target installation folder chosen by the user. 
 

The installation routine creates a COMPASS folder under the programs group on the Start menu 
with the Calcs icon in place. Double click on the Calcs icon to enter Calcs. A login screen will 
appear asking for your User I.D. and Password. 
 
1.5 Using Help 

Help is provided on-line with Calcs and is as extensive as the printed documentation. The on-line 
Help allows you to search by topic or keyword for the area in which you need help, and 
categorizes and defines words and phrases, giving you a clear picture as to what you are doing. 
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When you click on the Help menu item, a dialog box will appear with selections for using the 
help features of the system. Users can search for a specific topic of interest using the Index or by 
reviewing subject areas. Users may also review the version number of Calcs by clicking on the 
submenu item About. 
 
1.6 Technical Support of Calcs 

Technical Support of the system is provided by PDC Corp. Please be aware that support 
technicians will be handling many users, so you can help them by doing the following: 

  Careful reading of printed and on-line documentation of the System.  Please carefully read 
this documentation to be sure that your question or problem has not been addressed. 

  Make sure that the Data Sources section in your control panel is configured properly to run 
the Calcs database, which is called ACM.db. If you are not using Oracle, then the drivers 
for ODBC will also need to be loaded for proper program operations. 

  If you are running on a Network, check with your system administrator to make sure your 
workstation is configured correctly to run the program and connect to the database, and 
check that you have the rights to modify a file in the drive and directory where Calcs is 
loaded (namely, the database file ACM.db). 

  If your issue is not addressed in the documentation and you are satisfied that your system 
configuration is fine, feel free to call PDC Corp. Please have information about your 
system, including Windows version and type of network. 

 
1.7 Getting Started with Calcs 

The installation routine will automatically create ODBC connection profiles, path adjustments, 
and a COMPASS folder on the Start menu with an icon for the Calcs login screen. Click on the 
Calcs icon to directly access the Calcs main screen. 
 
1.8 Logging onto Calcs 

When you click on the Calcs icon in the COMPASS folder, a login window entitled, Calcs 
Emission Calculations Program will appear. If you are using an Oracle database, enter your User 
I.D. and Password and select Oracle from the selection list, and then click OK. Otherwise, you 
may leave the default entries alone and select SQLAnywhere from the selection list, and then 
click OK. (See Figure 1.1) 
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Figure 1.1 
1.9 Exiting Calcs 

To exit out of Calcs back to the desktop, simply select the Exit icon, or choose the Exit selection 
from the File menu. You will be presented with a confirmation of your choice, so select Yes. 

 
1.10 Conventions Used in This Documentation 

The Frame window is the main window in CALCS with a Frame toolbar (FrameBar) at the top 
and an empty workspace. (See Figure 1.2). A user can open one or more windows in the Frame 
workspace. These windows are called sheets. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.2 
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Each sheet is provided with a Sheet toolbar (SheetBar) at the top, and the workspace displays the 
corresponding data. (See Figure 1.3) 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.3
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CHAPTER 2:  CALCS OVERVIEW 
2.1 Facilities 

The Facility section of Calcs is the same as Facilities set up in the TaskTrakker module of 
COMPASS. A Facility, in this case, is the site.  It often uses the Account Number as the ID.  
You may, upon entering Calcs, select a default Facility (site) to work with and define emissions 
within that Facility. You may, of course, choose any Facility already set up in TaskTrakker to 
work with, but you may not modify certain Facility data, such as account number, once the 
Facility is updated in the Database. 
 
2.2 Units 

Units are generic process unit types, such as sulfur recovery units, tank farms, and powerhouse 
complexes. You may select the Unit to work with in Calcs, and you may modify existing Units. 
The same Unit may be used in multiple Facilities because it is a unit rather than a physical area 
in a specific plant. Units are associated with process streams and emission sources in Calcs. 
 
2.3 Compounds 

You will need to define all chemical Compounds for emission calculation purposes. Compounds 
are unique to Calcs because there is no corresponding entity linking the compounds to another 
module of COMPASS. 
 
Compounds are either single or multiple species compounds identified by a unique CAS Number, 
which may be a real or “dummy” CAS Number. Most of the columns that are presented to the 
user on the Compounds Detail screen contain physical/chemical data, such as molecular weight, 
TVP, and the coefficients to be used for vapor phase speciation (i.e., 3 parameter equation 
coefficients, 2 parameter coefficients, or vapor pressure – temperature data points for five 
different temperatures). Columns are also provided for SARA and HAP chemical identification; 
these “flags” are used under the Compound List icon to make compound lists that contain only 
SARA or HAP chemicals. A Category column is also provided so that users can produce criteria 
pollutant summary reports, as available under the Process Unit Reports on the Calculations 
window. 
 
2.4 Streams and Stream Properties 

Streams and Stream Properties are unique to Calcs as you may add, modify, and delete existing 
Properties. Stream Properties define each stream, which are contained under one or more Process 
Units. 
 
Stream properties may be used in emission calculations. Streams are generic liquid or gaseous 
fuels, materials, or emission streams. A single stream may be used in multiple Facilities. Only 
the data that will be used in a calculation formula is required to be filled in. For example, BTU 
value of a stream is important for fuel streams, and it may be left blank in a tank or loading 
stream. 
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2.5 Sources 

Sources are the sources of the emissions you will be calculating. Sources include boilers, 
engines, flares, manufacturing process units, and other equipment as well as area sources that 
generate air emissions. Unlike units and streams, sources are Facility-specific. 
 
2.6 Emission Factors 

You will need to define both the Emission Factors or Formulas and the corresponding equations 
for the emission sources contained within each Facility. Only when these factors are defined will 
you be able to calculate emissions. 
 
2.7 Profiles 

Emission Profiles are groupings of factors and formulas that are used to calculate a range of 
contaminant emissions for a source. 
 
2.8 General Equipment Information 

You will need to associate Sources with emission Profiles prior to calculating emissions. This 
task is accomplished under the General equipment information tab. Additional equipment 
information and emission point parameters may also be stored under General equipment 
information. 
 
2.9 Menu Structure 

2.9.1 File Menu 

The File menu of Calcs only allows one selection if no screens are open, which is to Exit the 
Calcs program. (See Figure 2.1) Use this selection when you are finished working in Calcs. After 
opening a screen, other options appear, such as New, Run, Close, Save, Save As, Erase, Print 
Preview, Print, and Print Setup, depending on the screen.. 
 

  
Figure 2.1 

2.9.2 Process Menu 

The Process menu in Calcs gives you direct access to the Emission Sources, Stream Properties 
and Compositions, and Emission Source Profiles. (See Figure 2.2) This menu also provides 
access to a feature, Copy Data To Another Year. This feature duplicates all process history 
records for a user-selected base year to a target year. If, for example, there are twelve process 
history records in the base year, one for each month, for a storage tank, then twelve records will 
be created in the target year for that tank. If desired, a Scaling Factor may be entered in the Units 
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window before using this feature. If the user enters a scaling factor of “0.5” for, say, Unit #2, and 
the Copy Data To Another Year feature is selected, then all process history records will be 
duplicated for the selected target year, but the process rate for all Sources that are located in Unit 
#2 will be changed to a value that is one-half as large as the values in the base year. Manually 
entered emissions may also be copied to a new year if this feature is selected by the radio button 
shown near the bottom of the screen. 
 

 
 

Figure 2.2 
 

2.9.3 Reference Menu 

The Reference menu allows you to go directly to the various windows to set up Facility Data, 
Compounds, Streams, and other data. (See Figure 2.3) The Reference menu is also where the 
Contractor Leak data can be imported. 
 

  
Figure 2.3 

2.9.4 Emissions Menu 

The Emissions menu allows you to Estimate Emissions from the data entered and View those 
Emission Results. (See Figure 2.4). 
 

  
Figure 2.4 

 
 

You may use these 
menu items instead of 

FrameBar icons 
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2.9.5 Options Menu 

The Options menu within Calcs allows you to select a default Facility to work within. Once the 
Facility is selected, you may only do data modification on equipment or sources within that 
facility until you select another default facility. (See Figure 2.5). 
 

 

2.9.6 Maintenance Menu 

The Maintenance menu (Figure 2.6) has five options and is viewable only when all screens are 
closed.  Stack Tests has fields for entry of stack test results to be used later as a basis for 
emission rates.  Compound Lists are lists made by the user for emission calculation of only 
certain compounds.  Source Type Display allows rearrangement of the order of Source Types in 
pick lists.  Disable Formula Edit allows locking and unlocking of general formulas such as those 
from AP-42.  Cleanup Database is generally used after calculating emissions to remove streams 
not used in the database, stream compositions not linked to a unit/stream, records showing zero 
emissions, and emissions not linked to current accounts or sources. 
 

   
 

Figure 2.6 
2.9.7 Window Menu 

The Window menu allows you to manipulate the Data Windows into the structure you wish to 
operate in Calcs. The Window menu also allows you to bring up the Toolbar configuration 
window. (See Figure 2.7). 
 

 

Figure 2.7 
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2.9.8 Help Menu 

The Help menu in Calcs gives you access to the on-line Help system and other information 
relating to Calcs and COMPASS. (See Figure 2.8). 
 
 

 
 
 

 
 
 

Figure 2.8 
 
2.10 Toolbar Configuration 

Calcs has toolbars that are the quickest navigational route to different windows and areas of the 
program. The Calcs FrameBar is the main toolbar that allows access to the various Windows. 
The FrameBar is, by default, positioned at the top of the screen. The Calcs SheetBar is a 
secondary toolbar that appears when each section window (sheet) is open. The SheetBar icons 
allow you to add, modify, delete records, update your editing changes to the database, and exit 
the window. 
 
You may customize the toolbars by choosing the Toolbar selection from the Window menu. This 
will open the Toolbar dialog box, where you may select the position of the toolbar relative to the 
screen and whether or not to show the text displayed with the icon. (See Figure 2.9). 
 
 
 
 
 
 
 
 
 

Figure 2.9 
 
2.11 Comments on Data Items 

You may enter comments in the database about various entities and other elements of Calcs 
wherever there is a Comments icon. Click on the Comments icon to open up a free form text box 
that will allow you to enter pertinent information that may not be contained within a field listing, 
or it will allow you to make notes to yourself or other Calcs users on the network. 
 
Once finished entering the notes and/or text desired, click on the OK button. To clear previous 
notes, click on the Clear Text button. To delete the entire comment entry, click on the Delete 
button. To undo without saving what you are presently doing, click on the Cancel button. 
 

Select the options you need for the 
Framebar and Sheetbar then click on 

Done 
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2.12 Steps in Entering Data into Calcs 

In order for Calcs to work correctly and generate the emissions data you need for inventory 
purposes, it is important that you follow these steps closely in entering and modifying data in 
Calcs.  In general, use the buttons from left to right.  Also, ID number fields recognize spaces 
and are case-sensitive.  PDC recommends entering ID’s using all CAPs and no spaces, unless it 
is necessary to duplicate a FIN.  This practice will reduce the possibility of errors that are 
difficult to trace. 

Step 1:  Locate an existing Facility or create a new one. 

Step 2:  Identify Units by either establishing new Units or by using the previously created 
ones. 

Step 3:  Enter and modify Compound data that will be needed for emission calculations. 

Step 4:  Assign Stream Properties and create stream compositions from Compounds 
previously entered. Calcs will automatically convert entered stream data into proper 
standard units of measure, and it will notate the stream type. Alternatively, use an 
existing stream type. 

Step 5:  Associate process streams and Units in the Unit/Streams screen. 

Step 6:  Create or modify emission Sources and define all types of equipment that create 
emissions.  Link the source to Units and Streams. 

Step 7:  Enter stack test data from the Maintenance menu, if such data will be used in 
emission calculations. 

Step 8:  Create or edit an emission factor or Formula for each contaminant that will be 
emitted. 

Step 9:  Create a Compound List if desired. 

Step 10:  Create an emission Profile, which is a list of Formulas or Stream Compositions. 
Alternatively, use profiles that already exist in the system. 

Step 11:  Link the Profile to an emission Source. 

Step 12:  Estimate emissions with the Calculate screen, view and print reports. 
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CHAPTER 3: CALCS ENTITIES 
3.1 Operating Facilities 

You may view and modify Facilities that exist in Calcs. Provided Facilities are resident in 
COMPASS, they will also be present in Calcs. 
 
To enter the Facility section of Calcs, select the Facility icon. This will bring up the Facility 
Information window (See Figure 3.1) where you may add, modify, or delete Facility information. 
 

 
Figure 3.1 

 
To select an existing Facility to modify, click on the drop down list on the Facility Code field. 
You will be given your choice of current Facilities resident in the system. Clicking on the desired 
Facility will fill out the data entry boxes with the currently installed data items for that particular 
facility. Notice the vertical scroll bars on the right side of your screen that will allow you to view 
the rest of the data. 
 
Once an existing Facility is selected, you may make modifications to the data that is present. 
Once you have made any modifications to the data, select the Save icon. This will update the 
database. Note that clicking on the Save icon first will result in a dialog error box appearing 
asking you to make a Facility selection first. (See Figure 3.2) 
 
 
 
 

 
 
 

 
Figure 3.2 

You must enter a 
Facility Code to 

proceed 

Select the Facility ID Number
from the drop down list,      

then fill out the data form 
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You may print the Facility information by clicking on the Print icon.  
 
Once you are finished editing data in the Facility section of Calcs, click on the Close icon. This 
will return you to the main screen. Be sure that you have saved changes to the database by 
clicking the Save icon before closing. 
 
3.2 Units 

To enter a Unit, click on the Units icon. This will open the Add/Edit Process Units window. 
  
To enter a new Process Unit, click on the Insert icon. This will open up a data box directly under 
the last existing Unit and place the cursor in that box. You may enter the data as needed, 
selecting the Save icon when finished. (See Figure 3.3) 
 

 

Figure 3.3 
 
You may delete an existing Process Unit by selecting the unit record you wish to delete. Click on 
the Delete SheetBar icon and you will be asked to verify the deletion, so choose Yes. To print the 
listing of Process Units, click on the Print icon. This will send the Process Units report to your 
printer. 
 
The Units screen includes a column called “Scaling Factor”. This factor may be used in 
conjunction with another feature to copy all of the process history data for all sources from one 
year to a future (or current) year. That feature is accessed by clicking on the Process menu, and 
then clicking on the menu item called “Copy Data To Another Year”. (See Figure 3.4) 
 

 

Figure 3.4 

Clicking on the Insert SheetBar 
icon inserts a row at the bottom 

of the form 



 

ACM-Calcs–Manual–Chapter 4 Page 14  

If the Scaling Factor for, say, Unit #1 is “1” or is not filled in, and the “Copy Data To Another 
Year” feature is selected, then all process history records will be duplicated for the selected 
target year. If there are twelve process history records in the base year, one for each month, for a 
storage tank, for example, then twelve records will be created in the target year, with exactly the 
same throughput. 
 

If the Scaling Factor for, say, Unit #2 is “0.5”, and the “Copy Data To Another Year” feature is 
selected, then all process history records will be duplicated for the selected target year, but the 
throughput for all tanks and loading racks that are located in Unit #2 will be changed to a value 
that is one-half as large as the values in the base year. In fact, all Sources located in Unit #2 will 
have their process or activity rate (e.g., fuel usage for combustion, flare gas burned for flares, 
etc.), changed per the scaling factor. 
 

Note that this feature does not scale emissions directly, only process rates. Therefore, the effect 
on emission estimation is as defined in the estimation formulas. If process rate is an important 
calculation variable (e.g., storage tanks), then the scaling of process rates will have a significant 
effect. If the process rate is a minor variable, or if it is missing altogether from the formula (e.g., 
fugitive emissions), then the scaling of process rates will have little or no effect on emission 
rates. 
 

Click on the Close icon when finished editing the Process Units data to return to the main Calcs 
screen. 
 
3.3 Emission Sources - Quick Edit Screen 

Users will note that there is a drop-down arrow located just to the right of the Sources icon. 
When this arrow is clicked, the Quick Edit icon can be selected, which enables multiple sources 
to be edited on a single screen. (See Figure 3.5) 
 

 

Figure 3.5 
 
3.4 Emission Sources 

Emission Sources, or the producers of emissions, can be edited under the Sources section of 
Calcs. To enter the Sources section, click on the Sources icon. This will open the Add/Edit 
Sources window. (See Figure 3.6) 
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Figure 3.6 
 
You must select the Source type to work with any Source on this screen. Selecting a Source Type 
and Equipment ID will open up data entry fields. (See Figure 3.7 and Figure 3.8) 
 
 

 

Figure 3.7 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 3.8 

 
An emission source needs to be linked to a Profile that contains one or more emission calculation 
formulas. These formulas are engaged during the calculation process. 
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Sources may be viewed or edited one at a time on the Sources screen or in a group for a specified 
time period and Unit, in the Quick Edit screen. Not all process variables are displayed on the 
Quick Edit screen. In general, only the variable(s) that are likely to change from one year to the 
next, such as throughput or fuel usage, are shown in the Quick Edit screen. 
 
You may print the Source listing by clicking on the Print icon. This will send the Source report 
to your printer. By clicking on the Comment button on the detail screen, you may make further 
informational entries into the comment box. (See Section 2.11: Comments on Data Items) 
 
Chapter 4: Source Types deals specifically with Source Types and explains each available 
Source type and its corresponding data entry fields that become available upon selection. Sources 
can be broken down into Secondary Sources, if desired. This would be done for any source for 
which the emissions must be calculated using more than one formula. 
 
An example might be a Loading Rack that has both working losses and blowdown losses, two 
types of emissions that are calculated in entirely different ways. Reactor vessels used in batch 
processes are often broken down into steps, and the emissions for each step are likely to be 
calculated in different ways (e.g., temperature increase, loading of catalyst, mixing, etc.). These 
steps can be identified as Secondary Sources, which can then be summed to the Primary Source 
that represents the total emissions from the reactor vessel (i.e., all steps). 
 
All Sources are automatically deemed to be Primary unless indicated otherwise in the Equipment 
Maintenance window. This window is accessed by clicking on Options menu while the Sources 
screen is open. Only the Account needs to be selected in the Add/Edit Sources window prior to 
retrieving the Equipment Maintenance. 
 
Each row in the Equipment Maintenance window represents one Source, as identified in the first 
column of the screen display. The column located along the right margin is used to indicate if the 
Source is “secondary” to a Primary Source. To indicate this, users click in this column and select 
the Primary Source from the drop down list of all sources. 
 
The Primary Source for which Secondary Sources have been identified is also highlighted, but 
the same Source ID is selected from the drop down list for the Primary Source – i.e, it is a 
primary source related to itself as a primary source. The actual summing of emissions from 
Secondary Sources into Primary Sources is done from the Inventory window by clicking on the 
Data menu item, and then on Sum Emissions. 
 
The Equipment Maintenance window is also used to correct or change a Source Type for a 
Source. This is accomplished by clicking on the second column entitled Source Type and 
selecting the correct Source Type from the drop-down list. Specific and general descriptions for 
Sources may also be edited in the Equipment Maintenance window. 
 

3.5 Import Function 

A third option is also available on most versions of Calcs, which is called “Import.” The drop-
down arrow to the right of the Sources makes this choice available. This function enables export 
and import of the Sources data from an external file format, such as an Excel file. While many 
file formats are available for users to export process data from Calcs, only the tab-delimited text 
file format may be used to load data from an external file into Calcs. 
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CHAPTER 4: SOURCE TYPES 
4.1 The Importance of Source Types 

Source types are the determining factor in many different areas of Calcs. Thus, it is important 
that you fully understand each Source Type and its use.  The Source Type does not need to be the 
same as in the EI module. 
 
Source Types define the equipment at the facility that generates emissions. All data entry screens 
that require source types to be entered as data fields have a drop down list with all the available 
source types. Select the one that fits with the data you are working with. Other data fields will 
appear in the same form depending on the Source Type you select. The following specific Source 
Type descriptions will give you an idea what data fields to expect upon that Source Type 
selection. Estimation Dates, Days On-line and Operating Hours are available fields for all Source 
Types. 
 
4.2 Specific Source Types 

4.2.1 Air Strippers 

Air Strippers are devices used to reduce the VOC concentration in a process stream. The data 
fields that are present with the selection of Air Strippers as a source type are as follows: 

 Stream Processed  Sand Filter Effluent VOC Concentration  
 Flow Rate  Outlet VOC Concentration 
 Inlet VOC Concentration  

 
4.2.2 Catalyst Handling Sources 

Catalyst Handling Sources create emissions as a result of handling catalyst. The fields that are 
present with the selection of Catalyst Handling as a source type are as follows: 

 Catalyst Type  Unloaded Units 
 Unloaded Amount  Percent Lost 

 
4.2.3 Combustion Sources 

Combustion sources are calculated emissions from heaters, engines and boilers.  The fields that 
are present with the selection of Combustion Sources as a source type are as follows: 

 Design Rate 
 Fuel Usage  Fuel Type Combusted 
 Fuel Usage Units  NOx Load Reduction Factor 
 Horsepower Liquid Fuel Used (gallons) 

 
4.2.4 Cooling Tower Sources 

Cooling Tower sources measure the emissions from cooling towers due to system leaks or 
chemical additives to the cooling tower water. The fields that are present with the selection of 
Cooling Tower Sources as a source type are as follows: 
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 Stream Processed  Flow Rate 
      Plant Feed Amount (M bbls) 

 
4.2.5 Drains, Sumps, and Junction Boxes 

Emissions from Drains, Sumps and Junction Boxes are determined by emission factors. The 
fields that are present with the selection of Drains, Sumps and JB as a source type are as follows: 

 Stream Processed  
 Number of Controlled Sources  Number of Uncontrolled Sources 

 
4.2.6 Equipment Leaks 

Equipment Leaks represent fugitive emissions. These emissions come from equipment like 
pumps, compressors, flanges, and valves. Before you may add data under this source type, you 
must have already set up the Leaks data in order for the stream name to appear in the drop down 
list. For the information needed on Equipment Leaks, see Chapter 8: Equipment Leaks. The 
fields that are present with the selection of Equipment Leaks as a source type are as follows: 

 Monitoring Program 
 Stream Name  VOC Percentage 

 
4.2.7 FCC Sources 

FCC Sources are Fluid Catalytic Cracking Units that have various emissions. The fields that are 
present with the selection of FCC Sources as a source type are as follows: 

 Type of Flue Gas  Wt.% Sulfur in Feed 
 Fresh Feed Amount  Flue Gas/Coke Ratio 
 Coke Production  Electric Precipitator & CO boiler? 
 Wt.% Sulfur in Coke 

 
4.2.8 Flares 

Flares burn gaseous waste products from refineries. The fields that are present with the selection 
of Flares as a source type are as follows: 

 Type of Gas Flared  Quantity Flared 
 Flare Efficiency  Flared Units 
 Crude Processed  Processed Units 

 
4.2.9 Loading Rack Sources 

Loading Rack sources represent emissions due to loading losses from tanks, truck, railcar or 
marine vessels. The fields that are present with the selection of Loading Rack Sources as a 
source type are as follows: 

 Product Type  Percent Control Efficiency 
 Throughput  Saturation Factor 
 Throughput Units  Max Temp 
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 Average Temp  Max Vapor Press 

 Average Vapor Press     Pumping Rate 
 
 

4.2.10 Oil Water Separation 

Oil Water separators receive the wastewater flow from process drains and junction boxes and 
remove the oil from the wastewater. The fields that are present with the selection of Oil Water 
Separation as a source type are as follows: 

 Stream Processed  Separator Type 
 Flow Rate 

 
4.2.11 Spills 

Some spills of VOCs result in emissions. The fields that are present with the selection of Spills 
as a source type are as follows: 

 Stream Spilled  Spill Units 
 Spill Amount  Percent Vaporized 

  
4.2.12 Storage Tanks 

Storage tanks have emissions as the result of vapor displaced during transporting of volatile 
liquids. The fields that are present with the selection of Storage Tanks as a source type include, 
but are not limited to, the following: 

 Product  Insolation Factor 
 State  Wind Speed 
 City  Pumping Rate 
 Min, Avg & Max Vapor Pressure  Constant Level Tank (Y/N) 
 Max Ambient Temp Tax  Constant Temperature Tank? 
 Min Ambient Temp Tan   

 
The fields on the Tank Data tab, such as diameter, height or length, and other variables change 
depending on tank type.  Floating roof tanks have an additional Tank Fittings tab for entering the 
number of columns, hatches, etc. 
 

4.2.13 Sulfur Recovery Sources 

The fields that are present with the selection of Sulfur Recovery Sources as a source type are as 
follows:  

 Sulfur Recovery Efficiency Percent  Emitted Units 
 Sulfur Produced  CEM Type 
 Produced Unit  CEM Concentration 
 Tail Gas Emitted  Type of Exit Flue Gas 
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4.2.14 Wastewater Treatment Systems 

Wastewater treatment system filters process wastewater from plant water runoff, including 
equalization tanks, aeration tanks, clarifiers, dissolved air flotation units, lagoons, etc. The fields 
that are present with the selection of Wastewater Treatment Systems as a source type are as 
follows: 

 Stream Processed 
 Flow Rate 
 Flow Rate Units 

 
4.2.15 User-Defined Sources 

Enter the Source Type User-Defined if none of the other Source Types fit the description for 
your specific equipment, or if the calculations for a particular source will be facilitated or 
simplified by using the User-Defined category. When a user makes a new source and identifies 
its source type as “User-Defined,” the General Description that is entered for that source will be 
used by the system as a source type subcategory. Examples of such subcategories include: 
Blowdown Losses, Reactor, and Process Vent. For each user-defined subcategory, the user can 
customize the data element labels that will be used by the system on the Detail screen for all 
sources that have the same General Description. Thus, when the first source of a specific user-
defined subcategory is created, the user creates data element labels that will be used for all future 
sources of the same type and populates the data values, at the same time, on the Source Detail 
screen. 
 
For example, to add a new source called “Reactor 101” to the system, the user clicks on the 
Sources icon to add the new source and enters the Equipment ID as “REACTOR101” (no 
spaces). The Specific Description might be entered as “Reactor for Product XYZ.” The General 
Description, which will serve as the source type subcategory, might be entered as 
“ReactorXYZ.” Then in the lower portion of the screen, the user might identify (“label”) the first 
data element as “Reaction Time” with a unit of measure of “Minutes.” The second data element 
might be labeled “Chlorine Used” with a unit of measure of “Pounds.” The third data element 
might be labeled “Temperature” with a unit of measure of “Degrees F.” Note that some data 
elements, such as Potential Throughput and Operating Hours, are pre-defined. Therefore, they do 
not require adding a label to identify the data that is entered for these items. The user could enter 
the values for these data elements at the same time that the labels are defined, but this is not 
necessary.  All fields need not be used. 
 
When the Detail screen is saved, the user-defined source type subcategory called “ReactorXYZ” 
will be stored in the system, much like a source type such as “Storage Tanks” is stored. The next 
time a source is added, if the user selects ReactorXYZ from the drop-down list of General 
Descriptions on the Detail screen, three data elements will automatically be presented to the user 
for data entry (Reaction Time, Chlorine Used, and Temperature). Also, when a new Formula is 
added on the Formula screen, if the user selects ReactorXYZ from the drop-down list of General 
Descriptions, three data elements will automatically be presented to the user for use in the 
calculation formula labeled: Reaction Time, Chlorine Used, and Temperature. 
 
Because of the capability to scale throughputs of sources in future years from a base year 
throughput and user-entered Scaling Factor, as explained in Section 3.2, it is advisable to use the 
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throughput data element that is provided by the system instead of creating a new label for 
throughput. However, if the scaling factor will never be used in connection with a User-Defined 
Source, there is no reason to use the throughput data element instead of a data element labeled 
“Throughput” that is created by the user. In some cases, such as in Loading Racks, a 
conventional AP-42 calculation formula might be used for the working losses during loading and 
a User-Defined “Secondary Source” (as discussed later in this manual) might be used, with its 
own user-specified formula, to account for Blowdown losses. The working and blowdown losses 
can easily be added together after calculations are done to estimate emissions for the entire 
Loading Rack. 
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CHAPTER 5: CALCS OPERATIONS 
5.1 Selecting the Operating Facility 

To select the desired operating, or “default” Facility, choose the Setup selection from the Options 
menu. You will be presented a list to choose the desired Facility in which to work. (See Figure 
5.1) This Facility selection will carry the desired Facility across Process Units and other entities. 
 
 

 
Figure 5.1 

 
5.2 Compounds 

A listing of Compounds and their related data can be edited by clicking on the Compounds icon. 
This will open the Add/Edit Compounds window. (See Figure 5.2) You may add, edit, delete, or 
print resident compounds. 
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Figure 5.2 

 
To add a new Compound, click on the Insert icon. This will bring a blank field listing at the 
bottom of the existing lists of compounds. Simply enter the data using the tab key to move to the 
next field. When you have added the new compound, click on the Save icon. This will update the 
database. Compounds are not related to any operating Facility; the same compound list is used, 
or can be used, for all plants. 
 
To delete an existing compound, click on the Delete icon. Be careful when you are deleting 
compound records, as there is no confirmation window in this section. To print a listing of 
compounds, click on the Print icon.  
 
5.3 Streams 

To work with Stream data, click on the Unit/Stream icon. Note that this icon is different from the 
Stream Properties icon. This will open up the Add/Edit Streams window. (See Figure 5.3) It is 
assumed that the Stream Property (i.e., “composition”) for any stream that will be added in this 
part of the program already exists. (See Section 5.4 for adding Stream properties) 
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Figure 5.3 

 
The reason for the Unit/Stream selection is to identify all of the Stream Properties that will be 
used in each process Unit in the plant. The stream properties are entered separately, as discussed 
in the next section. There are two reasons for separating the streams from stream compositions in 
the system.  

1. First, when process history is entered for a Source (as described in Section 3.4 of this 
manual), users are asked to identify the Stream(s) that are consumed in, stored in, or 
used by the Source during the process history time period. Sources are related to 
specific Units, just as the Streams are; thus, the system can provide a drop down list 
of Streams for this selection that is limited to the Streams associated with the Unit in 
which the Source is located. If there were no relationship of streams to units in the 
system, then the drop down list could contain several hundred streams, or more, for a 
large plant. Therefore, the Unit/Stream feature makes future use of the system more 
convenient and greatly reduces the potential for error (e.g., selecting the wrong 
stream for a Source).  It also allows for calculation of emissions by unit. 

 
2. Second, by separating stream compositions from streams, the user has more 

flexibility in using Streams in emission calculations. For example, several Streams 
can (and often do) reference the same composition; thus, if the composition changes 
in some, but not all, units, the user can add one or more new compositions and relate 
them to the Streams that have modified compositions (only). Also, if several Streams 
reference the same composition, and the composition changes for all streams, the user 
needs only make the change in one place, at one time, thereby reducing maintenance 
of the system. 

 
In short, the Stream and Stream Property concepts in Calcs is one example of using the power of 
a relational database, much like the Formula and Profile concepts discussed later in this manual. 
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The extra time that is spent in “set-up” for streams and compositions is more than offset by the 
increased convenience and more powerful maintenance capabilities that result from this aspect of 
the system. Streams, as well as Stream Properties (and many other system entities) are not 
related to any specific operating Facility. Even though streams are related to Units, the Units 
themselves can be generic, if the user wishes to set up the database in this manner. For example, 
if a company has several gas processing plants that have Amine Units, the Unit called “Amine 
Unit” can be entered only once, and an associated stream, such as “Amine Gas,” can also be 
entered only once. This stream can be associated with Sources located in several different 
operating Facilities. 
 
To add new streams to the database, click on the Insert icon. This will open a field box at the 
bottom of the current field listing where you may enter data. Much of the data to be entered in 
the Streams window consists of drop down list boxes. Simply click on the drop down portion of 
the box and scroll down until you find the desired entry. The Stream Composition is one such 
drop down list. 
 
You may also modify existing stream data by clicking on the field of the stream record you wish 
to modify. Simply overwrite existing data or make another selection with the drop down field 
listing. 
 
After stream additions and modifications are done to your satisfaction, click on the Save icon. 
This will update the database with your edits. To print the current streams, click on the Print  
icon.  
 
5.4 Stream Properties and Composition  

You may work with Stream Properties and compositions by clicking on the Stream Prop icon. 
This will open up the Add/Edit Stream Properties and Compositions window.  (See Figure 5.4) 
 

 
 

Figure 5.4 
 

There could be 
many compounds 

for each 
Stream Property record 
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When adding a new Stream Property, you may enter all of the compounds that are present in the 
composition. Composition data is required for streams that will be speciated based on the weight 
percent of components in the vapor phase, in which case the composition data may be entered for 
the liquid or vapor phase of the stream. For streams that will not be speciated, such as a fuel for a 
boiler, composition data is not necessary (but BTU value probably will be needed for a 
calculation, which is also entered on the same window). To enter compounds for the 
composition, simply make the selection from the drop down listing under the Compound section 
of the screen. When you are finished adding the data, click on the Save icon. This will update the 
database. 
 
The accuracy of certain calculations, such as Stream TVP, will depend to a great extent on the 
completeness of the composition analysis that is entered into the Stream Property. Hence, a 
running tally of the percentage of total stream composition is displayed, in weight percent, at the 
bottom of the screen while users input composition data. Note that a wide range of units of 
measure may be used to enter compounds in the composition (e.g., weight percent, weight 
fraction, ppm, etc.). When the Save icon is clicked by the user, all composition amounts that are 
entered in units other than weight percent are automatically converted into weight percent. 
 
To modify existing properties, select the property you wish to modify from the drop down listing 
at the Enter Lab/Sample ID field box. Selecting one property from the list will fill out the form 
with the data that has been previously entered. Simply make needed changes and click on the 
Save icon. 
 
You may also add or delete existing Compound records from each property. It is important that 
you understand that the Delete icon is for this purpose, while the Erase icon is for the purpose of 
deleting the entire Stream Property record. 
 
When you are finished with modifications, click on the Save icon. If you wish to create another 
unique property from the modifications you have just made, click on the Save As icon. This will 
allow you to keep intact the existing record(s). You will be asked to enter a new ID code to 
update the database. Once this code is entered and the database is updated, there will be a unique 
property record similar to the one you used to create the new one, with the new data resident. 
 
Liquid and Vapor Molecular Weight (MW) may be calculated on the Add/Edit Stream Properties 
and Compositions window, provided that the data needed to execute the required computations 
have been entered by the user (e.g., Reference Temperature for the Vapor MW computation). 
Simply click the Calc button by either the liquid or vapor MW field.  Message boxes will prompt 
the user for missing data as required for the calculations. Alternatively, users can enter the 
Liquid or Vapor MW instead of calculating the value. 
 
Stream Properties are not related to any specific operating Facility, nor to any Unit. The 
relationship of a Stream Property to a Unit is established when the user includes the composition 
in a Unit/Stream. Because the physical/chemical data that comprises Stream Properties often is 
communicated to the user from a sample analysis, the Add/Edit Stream Properties and 
Compositions window includes data elements such as Laboratory Name and Sample Date, which 
enable users to store the source of the analytical data as well as the composition. 
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5.4.1 NY–Stream Properties and Composition  

The CALCS module depends on Stream Properties information to determine emission rates of 
the specific chemical constituents that make up a material. Each material may be defined in the 
program by clicking on the Stream Properties icon on the main toolbar, as shown in Figure 5.5. 
 
 

 
Figure 5.5 

 
A material composition is referred to as a Lab/Sample Id. In the standard version of the CALCS 
module, a drop-down list of Lab/Sample Id.’s is displayed from which the user selects one item 
to edit or delete. In the New York version, due to the large number of potential materials 
(>200,000 items), users enter the Lab/Sample Id that they wish to view, change, or delete next to 
the phrase Enter Lab/Sample Id. If the material was previously entered, it will be found and 
displayed. Otherwise, the program will assume the material will be added to the list. 
Compositions may be updated automatically by using a feature that links to the “MSDS” 
database, shown in Figure 5.6. 
 

 
Figure 5.6 

 
The Stream Properties icon is also used to display, add, change, or delete materials that are used 
by continuous Sources, such as fuels, loading materials, and tank materials. 
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5.5 Stack Testing  

Stack Testing provides storage of data derived from laboratory analysis of streams, as well as 
pertinent operating conditions data. To enter the Stack Testing portion of Calcs, click on the 
Maintenance menu and select Stack Test from the list. This will open the Add/Edit Stack Testing 
Information window. (See Figure 5.7) 
 

 
Figure 5.7 

 
The Stack Testing data entry window allows you to enter information after selecting the Facility 
and Source Type via drop down lists. Enter the new Test ID and the rest of the relevant data 
values. Near the bottom of the form is the Compound entry where you may enter as many 
compound values for that test as needed. 
 
Once you have entered the new test data, click on the Save icon. This will update the database 
with the new test information. Minimum data requirements for a new stack test include Test ID, 
Test Description, Equipment (source) ID, and at least one compound. 
 
To make modifications to an existing test, select the Test ID from the drop down list after 
selecting the relevant Facility and Source Type. The previously entered data will appear, along 
with the list of compounds. If you only need to make modifications and not delete any portion of 
the compound record, simply make the necessary edits and click on the Save  icon. 
 
You may cancel certain compound entries by selecting the particular compound record and 
clicking on the Erase icon. It is important to note that Erase clears the compound record, while 
the Delete icon clears the entire Test ID record. Use the Delete icon only when you need to 
delete the entire portion of data appearing on your screen. 
 
You may also use an existing Test ID to create another similar ID by making necessary edits and 
clicking on the Save As icon. This will open up a window asking you to name the new ID. 
Remember that all fields of data from the previous ID that have not been modified will appear in 
the new ID. Stack test data can be included in a calculation formula, as discussed later in this 
manual. 
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To print the Stack Testing Report, select the Print icon. To exit out of the Stack Testing area, 
click on the Close icon. If any unsaved data remains on the entry form, you will be asked 
whether you wish to update those records to the database. 
 
5.6 Emission Source Profiles  

Emission source Profiles identify the compounds emitted from a certain type of emission source, 
as well as the methods used to calculate those emissions. Emission Factors are equations for 
each compound emitted during a process. A Profile is a group of these factors used to calculate 
all emissions for a particular source type; the profile can also include instructions for speciation 
of Total VOC into constituent compounds based on their weight percent in the vapor phase. 
 
To enter the emission source Profile area of Calcs, click on the Profiles icon. This will open the 
Emission Source Profile window. (See Figure 5.8) 
 
 

 
Figure 5.8 

 
You will need to first select the Source Type with which you wish to work. Then you may add a 
new Profile ID or select an existing ID to modify current data. Enter the Profile Description in 
the field directly under the ID field. The user includes the instruction of whether or not to use the 
vapor phase composition for speciation by making the appropriate entry on the screen. If this 
question is answered “no,” then the composition that was entered in the Stream Property will be 
used without conversion to the vapor phase (i.e., liquid phase weight percent will be used for 
speciation). If, for example, a user wishes to perform calculations for wastewater discharges 
along with air emissions, then a Profile can be included with this question answered “no” for the 
wastewater calculations. 
 
When you click on the arrow for Estimation method, a drop down list appears where you can 
choose from Emission Factors – Site-specific, Emission Factors – General, or Manually Entered 
Emissions. 
 
 
 
 
 
 
 
 



 

ACM-Calcs–Manual–Chapter 5 Page 30  

After choosing one, a dialog box appears with Factors, or Compounds, relevant to that Profile 
record. Select the Factors needed for the data you are working with. (See Figure 5.9) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 5.9 

 
Another dialog box also appears when you click on the Speciation drop down field list. When 
you select one of the entries from the list, a window entitled, Multiple Species Compounds, 
appears. (See Figure 5.10) 

 
Figure 5.10 

 
You may click on the desired item. Compositions may be entered directly from a pre-defined 
Stream Composition by selecting Using Stream Comp from the Speciation drop-down list.  
To save the existing Profile record, click on the Save icon. If you made changes to existing 
records, you may also click on the Save icon to update that particular record, or you may save 
those changes to another, unique, record by choosing the Save As icon and naming the new 
record. 
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If you are making changes to the compound listing under the Profile record, and you wish to 
delete a compound entry, select the desired compound and click on the Erase icon. This will 
delete that specific compound from the Profile ID.  Remember that clicking on the Delete icon 
will delete the entire Profile ID record, so use that icon only when needed. 
 
To print the Profile report, click on the Print icon. This will present the user with three choices 
for printing out the profile information: 

(a) print the profile on the display screen only. 
(b) print all profiles stored in the database. 
(c) print all profiles listed by site. 

 
To exit out of the emission source Profile area, click on the Close icon. If there is any unsaved 
data, you will be asked whether you wish to update the database. 
 
Profiles may be assigned to a Source in one of two ways, as explained in the following 
paragraphs:  
 

1. While the Profiles detail screen is open, users may click on the Link Sources icon or 
the Options menu located at the top of the screen and select Link Sources. This will 
open a screen in which Profiles and Sources are displayed in separate windows, and 
users may “drag and drop” the desired Profile to the appropriate window to save this 
link. (See Figure 5.11) 

 

 

Figure 5.11 
 

This screen also enables users to view the currently-assigned Profile for all Sources. 
A Profiles report is also available under the Options menu selection to enable a 
detailed review of Profile links to Sources.  
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2. While the Sources Detail screen is open on the first tab, users may click on the 
Profile data entry item and select from all Profiles that have been created for the 
selected Source Type to link the Source to a Profile. (See Section 3.4) 
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CHAPTER 6: EMISSION CALCULATIONS 
6.1 Formulas  

Formulas are the building blocks of the Emission Source Profiles in Calcs. To create a formula, 
you manipulate the objects you have at your disposal, including data elements, values, and 
mathematical routines. Once these formulas are created, they may be used in multiple instances 
(i.e., profiles) to calculate emissions. Should it become necessary to modify the formula, it can 
be changed in one place at one time, and all profiles that reference the formula will instantly be 
updated. 
 

To enter the formula area of Calcs, click on the Formulas icon. This will open the Add/Edit 
Emission Factors and Formulas window. (See Figure 6.1) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.1 

 
 

To add or modify formulas, you must first select the Source Type for the formula. If you are 
adding a new Factor or formula, enter the new formula name in the Factor ID field. If you are 
modifying an existing Factor ID, select that ID from the drop down list box. Once the Source 
Type and Factor ID (to be modified) are selected, the form accepts data in all other data fields. 
(See Figure 6.2) 
 
 
 
 
 
 
 
 
 
 
 
 

You may use these buttons 
like you would on a calculator 
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Figure 6.2 
 
The Columns box provides the variable building blocks for your formula. To enter one of those 
variables, you will need to double click that variable to add it to the formula. The mathematical 
tools to the left are there for you to manipulate the variables into the formula you need. Simply 
click on the calculation function you need for that particular variable. Some formulas are quite 
complex and may involve many variables (e.g., storage tank variables). 
 
The Source Type called User-defined is a special case for developing Formulas. That is because 
the User-defined Source data table is actually a generic spreadsheet-type table, in which the user 
defines the labels for data elements. The General Description field is used as a Source Type 
subcategory for User-defined Sources.  
 
When the user selects the User-defined Source Type in the Add/Edit Emission Factors and 
Formulas window and then selects a General Description from the drop down list, the windows 
on the screen appear slightly different but work the same way as for other Source Types. The 
Column Labels window on the right side of the screen displays the user-specified data element 
labels, while the Columns window on the left side of the screen displays the actual column 
numbers (i.e., from the data table). The user double-clicks on the column numbers in the 
Columns window on the left side of the screen to add a variable to the formula. (See Figure 6.3) 

 

 

 

 

 

 

 

 

The resulting formula 
text appears in this box, 

which you may edit 
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Figure 6.3 
 
By clicking on the Embed Formula button, a Formula Picklist is accessed showing previously 
defined formulas that can be add to a new formula.  Click OK after your selection. (See Figure 
6.4) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Figure 6.4 

 
To exit out of the Emission Factors window, select the Close icon. This will take you back to the 
main Calcs screen. 
  
6.2 Estimating Emissions  

The Estimate Emissions windows allow you to build the reports with which to view an estimated 
Emissions list. To enter the Estimated Emissions window, click on the Emissions menu, and then 
select Estimate Emissions.  Alternatively, click on the Calculate button. (See Figure 6.5) 
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Figure 6.5 
 
You must select Source Type, Equipment ID(s), and the Begin-End date range to establish the 
necessary parameters for emission estimation. Source data, such as fuel usage, pertinent to this 
date range will be utilized in the emission calculation procedure. 
 
You may click on the Up/Down arrows that appear on the right side of the date entry windows to 
change the Year, Day, and Month, after clicking in the appropriate area of the Begin/End data for 
the change. The begin date will automatically default to January 1

st 
of the preceding year, while 

the end date will default to December 31
st
 of the same year. 

 
You may specify a Begin-End date range that is longer in duration than the date ranges used for 
source data. For example, if monthly fuel schedules have been entered for January, February, and 
March of 2007 and the total fuel burned for the same source was entered for the period June 1 
through December 31 of 2007, then an emission calculation may be run for all of 2007, for the 
first quarter of 2007, or for the month of March (or any month mentioned). However, an 
emission calculation could not be performed for the month of July or for the third quarter 
because source process data does not exist for such time periods. 
 
After emissions have been calculated for the desired sources, click on the Use Existing Results 
check box and select a new report format from the Options menu. For example, a Source 
Summary report will sum emissions for all embedded date ranges within the Begin-End date 
range. The Emission Calculation Parameters report will show the methodology information, 
including formula, value of variables used when calculations were done, and the calculated 
emission values. (See Figure 6.6) 
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Figure 6.6 
 
6.3 Emission Inventory Summary 

The Emission Inventory Summary is a data table that contains all of the emissions for all sources 
and date ranges that have been calculated by the user, along with critical explanatory 
information. Click on the Inventory icon to bring up an Emission Inventory Search Criteria 
screen that enables users to specify the scope of the emissions data that will be reviewed. After 
the Facility ID, time frame, and other filter criteria have been entered in the criteria screen, the 
user clicks on the Retrieve command button to access the Emission Inventory Summary window. 
(See Figure 6.7) 
 

 

Figure 6.7 
 
You may delete rows from the Emission Inventory Summary window by selecting the row and 
clicking on the Delete icon. Multiple rows may be deleted by selecting one row and then 
selecting another row while holding down the <Shift> key. This will highlight all rows between 
the 2 rows selected with the mouse. Click on the Delete icon to delete any highlighted rows. 
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You may also enter Permit limit and reference data into rows of the Emissions Inventory 
Summary window. These items are located on the right side of the window and must be accessed 
by moving the horizontal scroll bar to the right. 
 
Users may sum up emissions from Secondary Sources into Primary Sources by clicking Data 
and Sum Emissions while viewing emissions in the Emissions Inventory Summary window. All 
Primary Sources are listed at the top of the Sum Emissions To Primary Sources window. When a 
Primary Source is highlighted by a single mouse click in this window, all emissions from related 
Secondary Sources appear in the bottom portion of the screen. (See Figure 6.8) 
 

 

Figure 6.8 
 
Several command buttons enable the user to sum up the Secondary Source emissions into the 
Primary Source and to delete them, or not delete them, depending on the button that is pushed. 
Command buttons also enable users to select all Primary Sources for summing with a single 
click. 
 
If the user has not taken the time to set up Secondary Sources and their relationship to Primary 
Sources in advance but still wishes to sum emissions, a feature is available for meeting this 
objective. By double-clicking on any row in the Emissions Inventory Summary window, a 
window with four different options is presented to the user to assist him in finding the emissions 
that will be summed. 
 
Regardless of the summing technique, any summed emission records in the Emissions Inventory 
Summary window are automatically displayed with a gray highlight, and a Summed note is 
entered into the comment column of the Inventory data table. Both a Print icon and File menu 
Print function are available to the user to prepare hard copy reports from the data presented in 
the Emissions Inventory Summary window. 
 
Users can re-calculate historical emissions using the Profile that was linked to the Source in a 
previous time period, if they wish. If the historical data exists in the Inventory data table and the 
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user has checked the check box on the Estimate Emissions screen labeled Use Profile Matching 
Selected Time Period, then the calculations will be performed in accordance with the information 
contained in the previously linked Profile instead of the currently linked Profile (assuming that it 
still exists in the system). 
 
6.4 Data Pipeline  

The data Pipeline is a feature designed to copy calculated emissions from the Calcs module to 
WinCeis (i.e., the Emission Inventory module). It is accessed by selecting the Pipeline icon from 
the COMPASS folder on the Start menu. As shown in Figure 6.9, the main tool bar enables 
choices to be made as to whether to “pipeline” equipment parameters or emissions, as well as 
whether to run maintenance functions such as for equipment relationships or contaminants. Most 
users will use this feature to copy emissions data only. 
 
 
 
 
 
 
 
 
 

Figure 6.9 
 
The procedure to copy emissions is to first select the Emissions icon from the Pipeline tool bar 
and enter the pertinent information on the retrieval screen to show the emissions that will be 
“pipelined,” and then click on the List icon to retrieve the list. (See Figure 6.10) Highlight the 
emissions that you want to be copied to WinCeis. 
 

 

Figure 6.10 
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In addition to copying emissions, the Pipeline feature also applies control efficiencies for all 
connected control devices and prorates emissions to connected emission points. Selections are 
available to turn these special processing functions on or off.  The Zero Out option will change 
all actual emission rate values to “0” before the pipeline is done, including emissions that are not 
affected directly by the Pipeline. Otherwise, if this checkbox is left blank, emissions that are not 
affected by the pipeline will retain their current emission rate value. 
 

 
6.4.1 NY–Pipeline  

The data Pipeline is accessed by clicking on the Pipeline icon in the COMPASS folder. As 
shown in Figure 6.11, the main toolbar has two reference lists to assist the user to synchronize 
data between CALCS and WinCeis for the export of emissions. They are Equip, which displays 
equipment relationships, and Contam, which displays a list of chemicals with the WinCeis-
assigned contaminant code and CALCS-assigned CAS Number.  In order for chemical-specific 
emissions to transfer from CALCS to WinCeis, it is necessary for the correct CALCS-assigned 
CAS Number to be correlated with the related WinCeis Contaminant Code. 
 

 

Figure 6.11 
 
The Batch Pipe icon provides a list screen to select batch Sources for transferring emissions from 
CALCS to WinCeis, as shown in Figure 6.12. The Emissions icon provides a list screen to select 
non-batch Sources for transferring emissions from CALCS to WinCeis, as explained in Section 
6.4. 
 



 

ACM-Calcs–Manual–Chapter 6 Page 41  

 

Figure 6.12  
 
6.5 Renames  

A special Rename icon is provided on the Pipeline toolbar. Users can use the screen that appears 
when this icon is clicked on to rename CALCS Sources that do not have the same Source Id as 
was used in WinCeis. This feature may not be used to add new Sources in either module nor to 
change Source Id’s in WinCeis. (Note: to change a Source Id in WinCeis, simply edit it in the 
Detail screen.) The renamed Source Id data entry column is labeled Rename to FIN on the 
Rename screen, as shown in Figure 6.13. 
 
The Err Reports icon enables users to review reports that can explain why a calculated emission 
rate is not transferring from CALCS to WinCeis. There are three possible reasons: 

1. The Source Id’s don’t match.  
2. The equipment relationship has not been defined or critical data showing the percent 

of flow from Sources to Control Device(s) and/or Emission Point(s) is missing, or  
3. The CAS Number for the chemical that is being emitted as shown in CALCS has not 

been associated with a valid WinCeis contaminant.  
 
More than one of these three conditions could exist at the same time. If one or more conditions 
do apply and are interfering with the Pipeline, users can easily correct the missing or incorrect 
data related to Source Id’s, flow routing, or contaminant code-CAS Number assignment, and re-
try the Pipeline when corrections are finished. 
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Figure 6.13 
 
 

6.6 NY–Emission Calculations for Batch Processes  

The Batch Calculation feature and related features, such as automatic updates from production 
and materials databases, are custom features that were added to the CALCS module especially 
for New York. Program functions related to creating Formulas and Profiles for continuous 
Sources, calculating emissions, summing secondary and primary Sources, and other features, are 
explained in the standard CALCS user’s manual. 
 
Batch calculations require extensive “setup” data to be entered into the system to identify how 
the batch processes operate. Once created, the Batch Source information may be updated with a 
more streamlined set of information to calculate emissions for future time periods. The Number 
of Batches field – an important data element that drives significant portions of the emission 
calculations – can be updated automatically from the PIMS database through a feature that is 
explained in the next section. (See Figure 6.14) This section concentrates on manual data entry 
by engineers or technicians who understand batch processes and are familiar with the type of 
information that will be required by the system to calculate emissions. 
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Figure 6.14 
 
A Batch icon appears on the main screen of CALCS, as shown in Figure 6.15, which may be 
used to access all batch-related functions. 
 
 

 

Figure 6.15 
 
Using this set of features, users can simulate a multi-step batch process with charge, drain, and 
clean out operations. Each set of batch emission calculations is associated with a product grade 
being manufactured. 
 
One reactor vessel can be in service for manufacturing multiple product grades. The emissions 
from each batch are then extrapolated to an annual emission based on the number of batches 
produced in a given year. The software estimates the potential to emit (PTE=total uncontrolled 
emissions) for a given source and the ERP (maximum uncontrolled emissions). 
 

6.7 NY–Using the Tabs to Navigate Batch Calculations Screens  

The user can enter any number of steps to simulate a manufacturing process. Each step can be 
associated with heating, pressurization, and material charging activities. The grade explorer on 
the left side of the screen keeps track of the various production batches being run. Each grade 
(product) represents a batch from a production standpoint and it is associated with one or more 
steps involved in the manufacturing process. The user specifies the operating parameters for each 
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step, for example the temperatures, pressures, etc. (See Figure 6.16) The user also chooses a flow 
condition which points to a control device network configuration utilized for emissions 
abatement. 

 

 
 
The second tab displays material input/output information. (See Figure 6.17) The user selects an 
input grade or raw material from a predefined set of materials stored in the database. These 
materials and their chemical compositions are user maintained. When a user selects an input 
grade, the corresponding chemical composition is displayed under grade composition. The 
number of pounds of each chemical fed to the reactor is calculated from the grade/material 
composition. 
 
 

 

Figure 6.17 
 
The bottom section of the Charge tab displays the material balance for the current step. The 
emissions are calculated based on the moles of vapor displaced during the current step. The 
volatility of various chemical species at the given temperature and pressure and the volume of 
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material charged affect the number of moles displaced. Heating, de-pressurization, and material 
charging all lead to vapor displacement from the reactor. The vapor pressures of various 
chemical species determine how much each will contribute to the total emissions resulting from 
vapor displacement. 
 
Chemicals charged into the vessel can participate in one or more reactions. (See Figure 6.18) The 
software identifies the limiting reactant based on the quantities of the reactants present during a 
given step and the reaction stoichiometry. The limiting reactant is the chemical species that will 
be completely consumed during a given chemical reaction, and the reactor will still be left with 
other reactants to spare. Hence, the reaction can only proceed when all of the limiting reactants 
are available. The program also accounts for the percent completion of a reaction. The maximum 
amount of limiting reactant that can participate in a given reaction will be dictated by the percent 
completion of the reaction. 
 

 

Figure 6.18 
 
Each step can optionally be linked to a control device that is integral to the process. (See Figure 
6.19) 
 

 

Figure 6.19 
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This control device is not a regulatory abatement device but a process control device, such as a 
condenser or a scrubber. The software performs a vapor liquid equilibrium calculation using the 
Newton-Raphson computation method. This calculation provides the final emissions after 
condensation/scrubbing. The resulting condensate can also be recycled to the system by selecting 
the Total Reflux checkbox. The calculations yield percent control efficiency for each chemical. 
This process results in generated emissions from a given step. 
 
The Calculations tab displays vapor pressures, vapor fractions, moles of liquid and percent 
control efficiency achieved from the process control step. (See Figure 6.20) If there is no process 
control, then the potential and calculated emissions are the same. 
 

 

Figure 6.20 
 
During the calculation process, if any missing parameters, such as molecular weights, densities, 
Antoine coefficients, etc. are detected by the program, it notifies the user through a list of QA 
codes. (See Figure 6.21) The QA codes will also trap value overruns – for instance, vapor 
fractions greater than 1.0. If a user inadvertently inputs more material than the reactor can hold, 
the system assigns QA code #12. Such user notifications can be very helpful to identify problems 
and ensure correct emission calculations. 
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Figure 6.21 
 

6.8 NY–“Rolling Sum” of Emissions  

WinCeis data is used to produce a report that shows the Rolling Sum of emissions from Batch 
Sources. This feature is run from the Batch Sources screen in the CALCS module, as shown in 
Figure 6.22. When run for a specific Source, this feature searches all records in the PIMS (i.e., 
Production database) to obtain a total number of Batches produced in each month during the 
prior twelve months. Emissions data in WinCeis is used to correlate the emission amounts with 
the number of batches, so it is important for users to have calculated emissions and to have used 
the data Pipeline to update WinCeis for any time period in which a Rolling Sum report is 
produced. 
 

 

Figure 6.22  
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CHAPTER 7: CALCS TUTORIAL 
7.1 What You Will Do  

The tutorial is a series of lessons in which you will estimate air emissions for an emission source 
in the refinery using the Calcs module. You will begin by creating a unit, a stream, a composition 
for the stream, a source, a formula, and a profile for the source. You will then link the estimation 
profile back to the emission source, calculate estimated emissions, and print a report. 
 
7.2 What You Will Learn  

After finishing the tutorial, you should know how to do the following: 
 Create an emission source  
 Create all pieces of information about that emission source  
 Create an emission profile  
 Create and use a compound list  
 Estimate air emissions for an emission source  
 Access/print the different types of emission reports  

 
7.3 Step Overview  

The following steps are what you will be doing in the tutorial. You will create a process heater, 
and estimate the VOC emissions and speciate the benzene emissions.  

Step 1:  Creating a unit - Calcs is designed to estimate emissions for sources included in a 
unit. 

Step 2:  Creating a process stream - A process unit has several incoming and outgoing 
streams to perform its ultimate process. This is where you define those streams and 
link them to the process unit. 

Step 3:  Creating a stream composition. A stream has several physical properties and is a 
mixture of several different compounds. When this mixture is processed, it emits 
these compounds into the air. 

Step 4:  Editing compound data - Compound properties are important for converting units of 
measure to a standard unit and are used in converting liquid compositions to vapor. 

Step 5:  Creating an emission source - An emission source is a piece of equipment inside of 
a process unit that performs a task that releases contaminants to the air. 

Step 6:  Creating an emission factor - An emission factor is actually a formula for 
calculating emissions for a particular compound. You build this equation by 
selecting parameters for the source you are building the equation for. 

Step 7:  Creating an emission profile - An emission profile is a group of emission factors 
and compounds to be speciated.  After you build a profile once, you can link it to 
several pieces of equipment for that source type. 
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Step 8:  Linking the profile to the emission source - A profile has to be associated with a 
piece of equipment before you can estimate emissions. Otherwise, the system 
would not know how to estimate emissions.  

Step 9:  Estimating emissions - This window provides you with different search criteria for 
calculating emissions.  

Step 10:  Viewing/printing the different reports. Now that you have calculated emissions you 
are ready to see the results! There are several different report options. 

 
7.4 Proceeding With the Tutorial  

7.4.1 Log Into the Database  

Before you start the tutorial, you will need to log into the database. Follow the directions in 
“Logging onto Calcs” in Section 1.7.  
 

7.4.2 Create a Unit  

Calcs is designed to estimate emissions for sources included in process units. Therefore, the first 
step in estimating emissions is defining one or more units, such as a powerplant or a sulfur 
recovery complex. 

1. Click on the Process Unit icon.  
2. A window with a list of resident process units appears. Click on the Insert icon. 
3. Enter a name for the process unit you are creating (e.g. Process Unit "SRU"). 
4. In the Process Unit Number column, type an ID number that corresponds with the name 

you gave the process unit (e.g. PU1). 
5. Use the tab key to move into the other columns to enter the necessary data. 
6. Click on the Save icon to record your process unit to the database. 
7. Click on the Close icon to exit this window. 

 
7.4.3 Creating a Process Stream  

A process unit has several incoming and outgoing streams to perform its ultimate process. This is 
where you define those streams and link them to the process unit. Like the process unit itself, 
streams are generic in nature. Thus the same process stream, e.g. Natural Gas, may be used in 
more than one  Facility. 
 
There are several stream parameters that are needed when estimating emissions in the vapor 
phase using a liquid composition. Be sure to complete these parameters before calculating 
emissions, otherwise emissions cannot be estimated: 

1. Click on the Unit/Streams icon. 
2. A window appears with the resident process streams. Click on the Insert  icon, which will 

insert a new blank row. 
3. Enter a name for the Stream Name (e.g. Process Stream 1). 
4. Use the tab key to move forward to the Stream ID column, where you will assign the new 

process stream an ID number (e.g., PS1). 
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5. Tab to the Unit column and click on the drop down list to display the list of units, and 
select the process unit you created in the previous step.  

6. As you move through the columns, the stream name scrolls off the screen. You can fix 
the columns so they never leave the screen by clicking on the small black bar at the left of 
the horizontal scroll bar and dragging the black bar to where you wish to split the screen. 
Once that is done, there will be two horizontal scroll bars at the bottom of your screen. 

7. Leave the Stream Composition field blank since we have not yet created the composition. 
8. Click on the Save icon to update the database. 
9. Click on the Close icon to leave this window. 

 
7.4.4 Creating a Stream Composition  

A Stream has several physical properties and is a mixture of several different compounds. When 
this mixture is processed, it emits these compounds into the air. Estimated multiple species 
compounds are speciated based on the weight percent of the compound in the stream. 
 
Stream properties are important for converting units of measure to a standard unit, and they are 
also used in converting liquid compositions to vapor. Be sure to complete these parameters 
before calculating emissions. Otherwise, emissions cannot be estimated. 

1. Click on the Stream Properties icon. 
2. To create a new composition, Enter Lab/Sample ID and press the tab key to move to the 

next field. 
3. Enter the Sample Description for the composition. 
4. Fill the remaining fields in the top portion of the window. 
5. Click on the drop down list box under Compound to select Benzene. 
6. Type in 1500 as the concentration of the compound you have added, and select ppmw as 

the unit of measure. If the units are other than wt%, they will be converted for you when 
you save the composition. 

7. Click on the Save icon. 
8. Click on the Close icon to exit out of this window. 

 
7.4.5 Editing Compound Data  

Compound properties are important for converting units of measure to a standard unit, and they 
are also used in converting liquid compositions to vapor. Be sure to complete these parameters 
before calculating emissions. Otherwise, the emissions cannot be estimated. 

1. Click on the Compounds icon. 
2. Make sure the compounds you selected for your stream composition have molecular 

weights and vapor pressures data such as Antoine Constants, 2-Parameter data or 5-point 
data. 

3. If you made changes, click on the Save icon, which will update the database. 
4. Click on the Close icon to leave this window. 
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7.4.6 Creating an Emissions Source  

An emission source is a piece of equipment inside of a process unit that performs a task that 
generates releases to the air. There are several different types of emission sources. They all have 
different operating parameters that are used to estimate their emissions. Fugitive equipment leaks 
are the most complicated.  

1. Click on the Sources icon. 
2. Click on the drop down list to select a source type. Choose Combustion Sources. 
3. To enter a new combustion source, type in an Equipment ID for the source. 
4. Select the Unit and the Stream you created earlier. 
5. Fill in the remaining process data including the time frame this data is valid for. These 

dates will be used as criteria for estimating emissions.  
6. Click on the Save icon. 
7. Click on the Close icon.  

 
7.4.7 Creating an Emissions Factor  

An emission factor is a formula for calculating emissions for a particular compound. You build 
this equation by selecting variables from the Columns list. 

1. Click on the Formulas icon. 
2. Click on the drop down list to Select Source Type. Choose Combustion Sources. 
3. To enter a new emission factor, Enter Factor ID.. 
4. Enter a specific description for your emission factor. Indicate whether this formula will 

calculate a Maximum (also called “Potential to Emit”) emission rate or an Actual (e.g., 
annual tons/year) emission rate, by selecting the appropriate Emission Type radio button. 
Also indicate whether this formula uses a General or a Site-specific calculation approach, 
by selecting the appropriate Type of Factor radio button. Formulas based on U.S. EPA 
AP-42 or American Gas Association factors would be examples of General formulas. 

5. Select Process Heater as the general description for this combustion source. 
6. Select VOC as the compound. 
7. Enter the Emission Factor as 5.5, and the EF units as lb/mmscf. 
8. In the Columns listbox, double-click the column name COMBS.cvt_fuelusage. You 

should see the formula change to reflect ‘ef * cvt_fuelusage’. Now click on the ‘/’ 
(division symbol) button and double click on COMBS.Operating_hours. The final 
formula should read ‘ef * cvt_fuelusage / operating hours’.  Spaces are allowed for 
readability and ignored in the calculations. 

9. Click on the Save icon. 
10. Click on the Close icon. 
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7.4.8 Creating an Emissions Profile 

An emission Profile is a group of Formulas and Compounds for speciation. After you build a 
Profile once, you may link it to several pieces of equipment for that source type. 

1. Click on the Profiles icon. 
2. Click on the drop down list to Select Source Type. Select Combustion Sources. 
3. Enter Profile ID for the new profile. 
4. Type in a Profile Description. 
5. Select No for Use vapor phase composition. 
6. For Estimation method, select Emission Factors–General. A popup window with a list of 

general emission factors for combustion sources appears.  
7. Scroll to the VOC emission factors and click on the EF Code or formula you created. 

Click on the OK button. 
8. Now choose Compositional Analysis–Manual for the Speciation method. A popup 

window with a list of multiple species compounds appears. Select VOC and press OK. 
9. Click inside the blank Compound field. 
10. Press B and choose Benzene from the list. 
11. Click on the Save icon.  
12. Click on the Close icon. 

 
7.4.9 Linking the Profile to an Emission Source  

Another method for linking profiles to source is described in the following six steps: 
Step 1:  Click on the Sources  icon. 
Step 2:  Click on the drop down list to select a Source Type. Choose Combustion Sources 

from the list. 
Step 3:  Select the piece of equipment you created earlier under Equipment ID. 
Step 4:  Click on the Profile drop down list. Select the profile you just created. 
Step 5:  Click on the Save icon. 
Step 6:  Click on the Close icon. 

 
7.4.10 Estimating Emissions  

After establishing Sources, Formulas, and Profiles, you are ready to calculate emissions. You are 
provided with different search criteria for calculating emissions. You may choose from one to 
many source types, process units, pieces of equipment, specific chemicals, and estimation 
periods. 

1. Click on the Calculate  icon. 
2. Click on the checkbox to activate the listbox for Source Types, and then select 

Combustion Sources. 
3. Check the Equipment ID check box and select the Source you created. (Note: In a large 

plant, equipment can be “filtered” by clicking on Process Units check box first, selecting 
a Unit, then clicking on the Equipment ID box to list the equipment associated with the 
selected Unit.) 
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4. The Begin date and End date are required fields. You must enter the dates exactly as you 
did on the piece of equipment, OR enter dates that include the date range for the piece of 
equipment. 

5. Click the RUN (green flag) icon. 
6. The results of your calculation will appear in the default or selected report format, as 

discussed below. Icons are provided to go to the next or previous page of the report, print 
the report, or Zoom back to the calculate window. A Print Preview feature is available 
under the File menu. 

 
7.4.11 Displaying and Printing Reports  

Once Emissions are calculated, you may view the results. There are several different report 
options, as discussed below: 

1. Select the desired report format from the Options menu. There are two types of 
reports: General and Process Unit. A total of eleven different formats are provided in 
these two categories. Under General Reports, all reports that have the word 
"Summary" in the report name will sum up emissions for the time period that was 
selected on the calculation screen, and they will only display the total emission rate. 
All other reports will present emissions separately for each time period for which 
process history data has been entered. To continue this lesson, select the Source 
Specific report under the General Reports category. 

2. Click the Use Existing Results checkbox in the Calculation Criteria. This will 
“unclick” the calculate button. 

3. Click on the green Run flag to view the report. 
4. Repeat this process for all the reports. To view a summary report, change the begin 

date to at least two years before the end date, so that it will pick up the previous 
results. 

5. Click the Save icon. 
6. Select the Close icon. 
7. To exit Calcs, select Exit from the File menu or the X in the upper right corner of the 

screen, then Yes in the confirmation box. This will take you out of Calcs.  
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CHAPTER 8: EQUIPMENT LEAKS 
8.1 Calculating Equipment Leaks  

Equipment Leak (or Fugitive) emissions data is usually supplied by a contractor. The user is 
responsible for creating the links between certain fields in both Calcs and the corresponding 
fields in the Source data files. The system has capabilities to import the data provided by the 
contractor, as long as the format that is used for this import procedure matches the format for 
which this feature was written (call PDC for details). 
 
There are several files needed for import. The first set of files imported will be the ‘leakers’ files 
that Calcs uses to enter in the component counts. The next set of files is the Totals file that Calcs 
uses to keep track of the total number of components in the facility. The total number of 
components and the number of zero leakers are determined by Calcs after processing this file. 
 
Once the data is imported, you set up equations in Calcs and calculate emissions. If you used 
correlation equations, Calcs will need to import the ‘leakers’ file again to input the specific leak 
rates into the equations. 
 
8.2 Setting Up the Data  

Before importing contractor data, you must first set up Calcs to accept the data for import. You 
will need to perform the following steps before attempting to import equipment leak contractor 
data:  

Step 1:  Make sure all the process units are entered.  
Step 2:  Define all the chemicals and compounds that will be needed for speciation of the 

stream data.  
Step 3:  Define all your streams, and enter the stream compositions in this window.  
Step 4:  Link the streams to each process unit in this window by inputting the first four 

columns. Also, the Leak contractor Stream ID and the Equipment leak stream 
category columns are necessary when importing data. If you will be speciating your 
VOC, the TVP and Deg F columns also need to be entered. The columns for Stream 
phase, VOC service, and TVP@68F are optional.  

Step 5:  To access these screens from the main window choose Reference, Equipment Leak 
Reference Data. Before continuing on to the  Source window, make sure you fill in 
the Leak Ranges, Leak Component Types, Leak Monitoring Programs, and Stream 
Categories. Calcs uses the Leak Ranges and Leak Component Types information in 
Sources to construct the Leak Count table for Equipment Leaks, so it is important 
that you consider what leak ranges you will need and the components to be 
monitored before proceeding.  

Step 6:  Consider each process unit as an Emission Source for fugitives. List the streams 
within each process unit that are monitored for fugitive emissions. The estimation 
dates should correspond to the frequency of the contractor data. 

 
If the contractor supplies data for each month (which is probably the most 
common), each Source should have 12 sets of records with different Estimation 
Dates (i.e. 01/01/2007–01/31/2007, 02/01/2007–02/28/2007. 03/01/2007–
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03/31/2007, and so on). When you access the Leak Counts table, Calcs constructs a 
table that includes all the information identifying the components in each stream. 
The Leak Counts column will be blank. When you import the data, the Leak Counts 
column will be filled in for you.  

TIP: If you choose to have multiple estimation dates (i.e. monthly), then 
only set up one estimation period (i.e. one month) and import the first 
month's contractor files. If errors are found, then you can correct the errors 
in that month's record. Once you have imported the files for one month, go 
ahead and save the emission source for the remaining 11 months. This way, 
each file will have the corrections already saved. This will save you a large 
amount of time if errors are found.  

Step 7:  From the main window choose Reference, Equipment Leak Contractor Data. These 
windows must be filled out so that the imported data will correspond correctly to 
the data in Calcs.  

Step 8:  Create an emission factor or correlation equation for each range group, monitoring 
program, component type, and stream category. A correlation equation calculates 
emissions by considering the actual ppm leak rate concentration of each component. 
An emission factor estimates emissions by considering the number of components. 
Both methods may be used. Be sure to select the radio button on the upper right 
corner of the screen that corresponds to either "Emission Factor" or "Correlation 
Equation". For the monitoring program, you may select "ALL" if the 
factor/correlation equation works for all the programs entered in Reference, 
Equipment Leak Reference Data, Monitoring Programs. For the equation, if you 
want to raise a number to a power, select the "^" button on the square button to the 
left of the equation box. When "^" is selected, the formula "f_exp(x,y)" will appear, 
which represents xy. You need to replace the x and y with the actual values. For 
instance, 5

3
 would be ‘f_exp(5,3)’ and (leak_rate)

0.82
 would be ‘f_exp(leak_rate, 

0.82)’.  
Step 9:  Set up an Profile for calculating Equipment Leak emissions based on the factors set 

up in Formulas. When selecting estimation methods, you may choose both 
correlation equations and emission factors, which you may have set up for different 
leak ranges in Step 8.  

Step 10:  Link each Source to the Profile. You may do this faster for multiple sources in the 
Profiles window by selecting Options, Link Equipment. 

 
8.3 Importing Contractor Data 

The second file is a listing of the total number of components by stream in the plant during that 
estimation period. The information must be in a specific format. 
 
From the main window, select Reference, Equipment Leak Contractor Data, Import and Process 
Leak Counts. This will bring up the Import window. 
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8.3.1 Leakers 

Always enter the Leakers file first! 
1. Enter the leak time period covered by the file to be imported. (Note only one file can be 

imported at a time). 
2. Select the leakers file by choosing Browse. 
3. Make sure the Leakers box is X'd. 
4. Select Import to begin importing the leaker data. When the import is complete, the data 

will be output to the screen. 
5. Next, select Process on the toolbar. This function places the leak counts into the Leak 

Counts column within the Source table. Some of the rows may get highlighted in blue. 
This means that the data does not match with the information in Calcs. When processing 
is complete, a status box will appear saying either that the process was successful or that 
the contractor supplied data could not be processed. Click OK, and a reminder will appear 
saying to Process Totals now to calculate zeros. 

6. If certain rows could not be processed, see “Common Errors That May Cause Data Not 
To Be Processed:” in Section 8.7 on how to resolve data that could not be processed. 
Correct the data and repeat Step 5. 

 
8.3.2 Totals and Zeros  

If you have not processed the Leakers file, do so before proceeding! 
1. Select the Totals file by choosing Browse. 
2. Make sure the Totals and Zeros box is X'd. 
3. Select Import on the toolbar to begin importing the Totals data. This may take several 

minutes to complete because Calcs is reading and inserting each row into the database.  
When the import is complete, the data will be output to the screen. 

4. Select Process on the toolbar. This function inserts the total counts in the appropriate row 
in the leak counts tables in Sources. Next, it will calculate the zero leakers by subtracting 
the number of leaking components from the number of total components. Some of the 
rows may get highlighted in blue. This means that the data does not match with the 
information in Calcs. When processing is complete, a status box will appear saying either 
that the process was successful or that the contractor supplied data could not be 
processed. Click OK. 

5. If certain rows could not be processed, see Section 8.7 on how to resolve data that could 
not be processed. Correct the data and repeat Step 4. 

6. Close out of this window and select Sources. Select an Equipment Leak emission source 
and proceed to the Leak Count tab. Check to see that the process worked. 

7. Repeat all importing steps for the remaining estimation periods. 
 
8.4 Calculating Emissions  

After importing the Contractor Data, you are ready to calculate emissions. Go to the Calculate 
window, and calculate emissions for the Equipment Leak sources as you would for any other 
source. 
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If correlation equations are used to estimate emissions, the user must enter estimation dates that 
correspond to the estimation periods used when setting up the emission sources, and do a 
calculation for each estimation period (i.e. 1/1/2007–1/31/2007). Calcs will prompt the user to 
"Select the files for use in the correlation equation." Choose the Leakers file that corresponds to 
the correct estimation period, and Calcs will read the actual leak rate values from the Leakers file 
and input them into the correlation equation. This will take several minutes because Calcs will 
have to import the file again. Repeat this process for each estimation period. When all the 
emissions have been calculated once, you may select an estimation period that spans all the 
estimation dates to sum up these emissions if you mark the box Use Existing Results before 
selecting Run.  For instance, if you chose to set up monthly estimation dates for the year 2007, 
you may choose 1/1/2007–12/31/2007 in this window to calculate the emissions for the entire 
year. If no correlation equations were used to estimate emissions (only emission factors used), 
you may choose 1/1/2007–12/31/2007 whether or not you had calculated emissions once before. 
This is possible because Calcs does not have to pull in any import files for emission factors. 
(You may also calculate multiple date ranges simultaneously for any other Source Type in 
Calcs.) 
 
You may display the results in several different report formats if you choose Options and the 
desired report under General Reports or Process Unit Reports. Select Use Existing Results, and 
then Run. The Source Detail report will give you the most detailed information, including a 
listing of the leak counts. This report is good for QA/QC of the data. The  Source and Stream 
Summary report sums up emissions by source and stream. The General Description Summary 
report totals all the fugitive emissions on one page. 

 
8.5 Format of Contractor Data  

The imported files must be in a specific format, and your contractor should be able to supply you 
with the data in the correct format at minimal cost. Usually, the contractor charges a one-time fee 
for the initial programming to get the data in this format, but should not charge any more to 
continue supplying the data in this format. 
 
First, decide how frequent you would like to obtain fugitive data. Some plants desire the ability 
to quantify each month's emissions, and others only require quarterly emissions reports. Still 
others may only need an annual report. Note that monthly emissions gives you the most 
flexibility. You can easily sum the emissions for each year if needed. On the other hand, a yearly 
report cannot be broken down by emissions occurring in each month. Consider this step carefully 
before proceeding. 
 
Next, ask the contractor to supply you with data. It must be ASCII (text) files in comma 
delimited format with the specified character format for each estimation period. An example of 
comma delimited format is: "01/01/2007","01/31/2007","01234","NSPS","ASPHALT". If you 
choose monthly emissions, you will get 12 sets of files, one set for each month in a reporting 
year (2 files per set). 
 
For each estimation period, the contractor will need to supply you with two files: a Leakers file 
and a Totals file. The leakers file is a listing of all the leaking components and their ppm leak 
rates during the estimation period. (Note that we are considering leaking components as any 
component leaking above background zero, not the regulatory 10,000 ppm definition.) The totals 
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file is a listing of the total number of components by stream in the plant during that estimation 
period. 
 
The information in each file should be the most recent available. For instance, if a certain unit is 
not monitored during the time period of interest, then information for that unit should be 
obtained from the most recent past data. If the past data indicates that a particular component 
was screened at 1000 ppmv, then it should continue to be recorded in these monthly tables as 
being screened at 1000 ppmv until it is monitored differently in the future. All components in the 
plant should be accounted for in these tables each month, regardless of how many are monitored 
each month. 
 
The Unit and Stream Information has a primary and secondary priority to it. The Unit ID and 
Stream ID should always be filled in. If the only data available is the Unit name or Stream name, 
then this data should be placed in the Unit/Stream ID column with the Unit/Stream Name column 
blank. If this is the case, the format restricts the number of characters to the specified format. 
 
The reason why the blank column exists in the Totals file is that the two files need to have the 
same number of columns so that Calcs can import the files correctly. The contractor format will 
read: "01/01/2007","01/31/2007","NSPS",,"ASPHALT" and so on. Note the 2 commas that 
indicate a blank column. 
 
8.6 Resolving Unprocessed Data  

After you have imported contractor equipment leak data and have run the "Process" data step, 
you may find that a number of records could not be processed. This is because something in 
Calcs is not linking correctly with the contractor data. You may have left a necessary piece of 
information out of a record, the contractor may have added streams that you don't have input in 
your records, and so on. 
 
The rows that could not be processed are highlighted in blue on the "Import and Process" screen. 
You may view these rows by scrolling down the file line by line. Note the first highlighted row. 
Without closing this screen, click on the following items to determine what the problem may be. 
(Do not close the import screen, or you will have to repeat the entire process of importing and 
processing the data. You may have many windows open at one time, and an easy way to switch 
between open windows is the select Window from the menu bar and the correct window to view.) 
 
8.7 Common Errors That May Cause Data Not To Be Processed 

If you find that you only need to make a change to a few items, it may be quicker to manually 
input the leak count. Do this by going to the Leak Count window in the Sources screen, entering 
the leak count, and saving. 

1. From the Import window, select Reference, Process Units. Check to see that the correct 
Process unit ID is entered. If not, add it from this screen. 

2. From the Import window, select Reference, Component Types. Check to see that the 
abbreviations used by the contractor correspond to the existing abbreviations in this 
window. If the abbreviation does not exist, add it to this window. 
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3. Click on Sources on the toolbar. Check to see that the stream has been added to the 
correct emission source record. If not, add the stream and save. If you add a stream in 
emission sources, check to see that the Leak Contractor Stream ID has been listed in 
Unit/Streams. 

4. Also in Sources, check to see that you have the correct estimation dates. If not, create a 
record with the correct estimation dates and save. 

5. Click on Unit/Streams on the toolbar. Check to see that the correct ID for the stream is 
listed in the Leak Contractor Stream ID column. If the contractor has a different stream 
ID, either: 
(a) add another stream with the same information except the new stream ID (i.e. if stream 

is fuel gas, rename fuel gas-2), or 
(b) change the stream ID, as long as the contractor did not use the existing stream ID for 

any of the imported streams. 
 
If (a) is done, add this new stream to the emission source record. 
 
If for some reason the contractor has monitored components or streams that you do not need to 
report or calculate emissions from, then simply ignore this highlighted row. The data will not be 
imported. 
 
After troubleshooting is complete, you will need to reprocess the data from the Import window 
by selecting Process. If rows are still incompatible, the rows will be highlighted in blue. Repeat 
this troubleshooting procedure until all the errors are found. Remember, if you find that you only 
need to make a change to a few items, it may be quicker to manually input the leak count. Do 
this by going to the Leak Count tab in Sources, entering the leak count, and saving.  
 


